HDR 24/96

QUICK START GUIDE

24 TRACK/24 BIT, DIGITAL AUDIO HARD DISK RECORDER AND EDITOR

MACKIE®

Digital Systems
Important Safety Instructions

1. Read instructions — Read, understand and follow all safety and operating instructions before using the HDR24/96.

2. Retain Instructions — Keep these safety and operating instructions for future reference.

3. Heed Warnings — Follow all warnings on the HDR24/96 and in these operating instructions.

4. Water and Moisture — Do not use the HDR24/96 near water — for example, near a bathtub, kitchen sink, garden hose, incontinent poodle, sweaty drummer, etc. — or when condensation has formed on the unit.

5. Heat and Ventilation — Locate the HDR24/96 away from heat sources such as radiators, campfires, compost pits, hellion welders, magma flows, etc. Do not block HDR24/96 ventilation openings or install in spaces that prevent adequate air circulation to the unit.

6. Power Sources — Connect the HDR24/96 only to a power source of the type described in these operating instructions or as marked on the HDR24/96.

7. Power Cord Protection — Route power supply cords so that they are not likely to be walked upon, tripped over, or abraded by items placed upon or against them. Pay particular attention to cords at plugs, convenience receptacles, and the point where they exit the HDR24/96.

8. Object and Liquid Entry — Do not drop objects or spill liquids into the HDR24/96. Clean only with a damp cloth; do not clean with liquid or aerosol cleaners.

9. Attachments — Use the HDR24/96 with only the accessories specified in this manual.

10. Damage Requiring Service — The HDR24/96 should be serviced only by qualified service personnel when:
   A. The power supply cord or the plug has been damaged; or
   B. Objects have fallen onto, or liquid has spilled into the unit; or
   C. The unit has been exposed to rain or water; or
   D. The unit does not appear to operate normally or exhibits a marked change in performance; or
   E. The unit has been dropped, or its chassis damaged.

11. Servicing — Do not attempt to service the HDR24/96. All servicing should be referred to the Mackie Service Department.

12. Lightning — Unplug the HDR 24/96 during lightning storms or when unused for long periods of time.

13. Grounding and Polarization — To prevent electric shock, do not use the HDR24/96 polarized plug with an extension cord, receptacle or other outlet unless the blades can be fully inserted to prevent blade exposure. Do not defeat the HDR24/96 grounding by plugging into an ungrounded receptacle or ground lift adapter.

This apparatus does not exceed the Class A/Class B (whichever is applicable) limits for radio noise emissions from digital apparatus as set out in the radio interference regulations of the Canadian Department of Communications.

ATTENTION — Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de class A/de class B (selon le cas) prescrites dans le règlement sur le brouillage radioélectrique édicté par les ministère des communications du Canada.

FCC Information

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital devices, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

This product has been tested and complies with the following standards and directives as set forth by the European Union:

* EN 55022 Radiated and Conducted Emissions
* EN 61000-4-2 Electrostatic Discharge Immunity
* EN 61000-4-3 RF Electromagnetic Fields Immunity
* EN 61000-4-4 Electrical Fast Transient/Burst Immunity
* EN 60950/IEC 950 Electrical Safety Requirements

WARNING — To reduce the risk of fire or electric shock, do not expose this appliance to rain or moisture.

WARNING — Before applying power to the HDR24/96, make sure that the Voltage Selector switch next to the AC inlet jack on the rear panel is set to the line voltage used in your region. Powering-on the HDR24/96 with the Voltage Selector switch set incorrectly will cause an electrical and fire hazard that may result in irreparable damage to the unit.
Contents

Introduction ----------------------------4
Conventions ----------------------------5
About “Tape” --------------------------5
Overview -----------------------------6

Setup & Configuration ------------------7
Required Equipment ----------------------7
Installation -----------------------------7
I/O Cards & Cables ----------------------8
Sync Card & Cable - Word Clock and Digital
Synchronization --------------------------10
Mackie Media (Optional) -----------------12
Monitor / Mouse / Keyboard (Optional) ---13
Remote 24 / Remote 48 Pro (Optional) ----14
Footswitch (Optional) -------------------14
Power-Up ------------------------------14
Configuration ---------------------------15
I/O Cards ------------------------------15
Synchronization ------------------------19
Hookups -------------------------------20
Analog Hookup (AIO¥8) ------------------20
TDIF Hookup (DIO¥8) ---------------------22
ADAT Optical Hookup (DIO¥8 or OPT¥8) ----24
AES/EBU Hookup (PDI¥8) ------------------27

HDR24/96 Operation ---------------------29
Opening Projects -----------------------29
Basic Transport Operations --------------30
Time Displays ---------------------------31
Locate Points and Looping-------------32
Cues -----------------------------------34
Creating Projects --------------------36
Naming Tracks -------------------------38
Monitoring -----------------------------38
Metering and Setting Levels -----------40
Recording -----------------------------42
Autopunch -----------------------------44
Footswitch Operation ------------------45
Delete Last -----------------------------46
Saving Projects ------------------------46
Project Backup / Restore --------------47

Appendix A: Compatible Cables ----50
Analog and Digital Multitrack Cables ----50
Other Cables ---------------------------51

Troubleshooting and Service -------54

Please write your serial number here for future reference:

Purchased at:

Date Of Purchase:

© 2000 Mackie Designs Inc., All rights reserved
Printed in the U.S.A.
Introduction

Save your Box!

Uncle Jeff’s Bottom Ten Reasons to Save the Box:

10. You think boxes grow on trees?
9. It’s actually a time capsule, packed with a biological code that can’t be decrypted until 2043.
8. Its festive graphics will cheer up those other boxes forgotten in your attic.
7. Impress your friends: tape it up and pretend that you actually have two HDR24/96s.
6. If you throw it away, bad people will know you have a studio in your house.
5. Someday, when paper costs more than steel, it could net you a fortune.
4. The HDR24/96 itself only costs $47.95. The balance is what you paid for the box.
3. Properly sealed, it can be used as a flotation device in the unlikely event of a water landing.
2. It’s a great place to hide your old digital 8-track recorder.
1. If you collect ten HDR24/96 boxes, Greg will come over for dinner (this offer does not apply to dealers or distributors).

In the unlikely event that you should need to send the HDR24/96 back to Mackie for service, please use the shipping box it came in. This box has been specially designed to minimize damage to the HDR24/96 during shipping, so that it won’t end up more broken than when you sent it.

How To Use This Guide

Welcome to the cutting edge of affordable multitrack recording and editing! We know you’re feeling eager, but please take a few minutes and read this brief Quick Start Guide before you jump into your first HDR24/96 session. The first part of this guide explains how to install and configure the various HDR24/96 I/O cards and connect the HDR24/96 to an analog or digital console. The second part describes how to start a session, operate the basic transport and monitoring controls, and explains the terms and conventions used to name, store, and retrieve projects on disk.

To get the most out of this guide, you’ll need to be familiar with the basic multitrack recording process. To take advantage of the built-in Graphical User Interface (GUI), you’ll need to attach a standard SVGA computer monitor, mouse, and keyboard. This Quick Start Guide covers both front panel and GUI operation.

We have purposely excluded all the extra stuff from this guide to give you just the basic information you need to get going right away. For step-by-step tutorials, in-depth feature descriptions, and endless technical details, see the Applications and Reference Manuals on the companion CD-ROM. Updated manuals and the latest software releases can be obtained via Mackie’s website at: www.mackie.com.
Conventions
The HDR24/96 Quick Start Guide uses the following conventions to help you find information quickly:

Text Conventions
a) Keyboard Keys (example: \texttt{SHIFT})
b) Keyboard keys you hold at same time (example: \texttt{CTRL+SHIFT+6})
c) File or folder names (example: \texttt{C:\HDR Projects\Ode To Masters\Ode To Masters.hdr})
d) Software or hardware controls (example: \texttt{Punch})
e) Proper names of objects in GUI or front/rear panel (example: \texttt{Transport})

Icons
This icon identifies a description of how to perform an action with the mouse.

This icon identifies a description of how to perform an action with the keyboard.

This icon identifies a description of how to perform an action from the front panel.

This icon identifies in-depth explanations of features and practical tips. Though not required reading, they do offer some choice tidbits of knowledge that will leave you wiser for the reading.

This icon identifies information that is critically important to the operation of the HDR24/96. So for your own sake, please read these sections.

About “Tape”
No, you’re not reading the wrong manual. Our goal was to build a hard disk recorder that is comfortable for someone familiar with tape recording, but that doesn’t require you to get a brain transplant from a computer geek to use. When familiar terms such as Tape Inputs, Tape Returns, Transport, and the like are applied to the HDR24/96, they mean exactly what you expect them to mean. Where the well-worn shoe fits, we continue to wear it.
Overview

By combining traditional multitrack tape recording features with the power and flexibility of graphical non-linear editing, the Mackie Designs HDR24/96 takes multitrack recording to a level never before achieved by a product in its price range. In addition to the standard battery of traditional tape-based features, the HDR24/96:

- Combines the familiarity of a multitrack tape machine with the security of non-destructive recording and non-degrading recording media.

- Includes a Graphical User Interface and a built-in DAW-style editor, accessible by adding an SVGA monitor, two-button PS/2 compatible mouse, and a standard PC keyboard.

- Can record simultaneously on all 24 tracks. At either 44.1 kHz or 48 kHz sample rate, the internal hard drive will store over 2100 track-minutes of 24-bit audio. That’s 90 minutes of 24 full tracks, six reels worth at 30 inches per second!

- Has eight Virtual Takes per track, allowing you to record multiple passes without having to change routing and bussing assignments or use additional tracks.

- Can interface with any analog or digital console. The HDR24/96 uses the same I/O cards as the Mackie Digital 8 Bus console: the AI O•8 (24-bit analog A/D and D/A), DI O•8 (TDIF/ADAT Optical), PD I•8 (AES/EBU), and low-cost OPT•8 (ADAT Optical).

- Provides three convenient methods of backup: Mackie Media M•90, a removable hard drive (also capable of 24-track recording and playback), Mackie Media PROJECT, a removable drive using inexpensive, removable 2.2 GB ORB cartridges; and data transfer to another computer through the HDR24/96’s 100 Base-T Ethernet port via the built-in FTP server.

- Offers two optional remote control devices – the compact Remote 24 for smaller project studios, and the full-featured Remote 48 Pro for controlling up to 48 tracks with full Auto-Locater and Jog/Shuttle Wheel.
Setup & Configuration

This chapter explains how to set up and configure the HDR24/96 for use in your studio. Two application examples show how to interface the HDR24/96 with analog and digital recording consoles.

Required Equipment

Of course, there’s more to a studio than a recorder and some musicians. At a minimum, you’ll need the following to make the HDR24/96 feel at home:

- 3 Mackie 8-channel I/O (input/output) cards.
- A console with a minimum of 24 tape sends (busses or direct outputs) and returns (line inputs or monitor returns). If your analog console has only 8 tape sends, use Y-cord splitters to send tape out 1 to HDR24/96 Inputs 1, 9 and 17; tape out 2 to HDR24/96 Inputs 2, 10, and 18, and so forth.
- Cables to connect the HDR24/96 to the console: 3 or 6 multi-channel snakes or fiber optic cables, depending on your I/O setup.
- All the stuff that typically connects to a console: microphones, instruments, outboard equipment, control room monitors, and so on.
- Optional, but strongly recommended: an SVGA monitor, two-button PS/2 mouse, and PC keyboard for the Graphical User Interface.

Installation

This section describes how to install the I/O cards and how to connect the HDR24/96 to your console. Before you begin, you should choose a location for your HDR24/96 considering the following:

- If you’re not using the GUI interface, Remote 24, or Remote 48 Pro, position the front panel within convenient reach of your normal recording/mixing position. If you are using the GUI interface, you might want to get the HDR24/96 out of the way. Be aware that although analog and AES/EBU cables can be fairly long, TDIF Optical and Remote 24/Remote 48 Pro cables are limited to about 10 meters. ADAT Optical and KVM (keyboard, video, mouse) cables can reach up to about 15 meters.
- The HDR24/96 requires a reliable AC power source with a good ground. Do not use a ground lift adapter or plug the HDR24/96 into an ungrounded receptacle. Remember, this is a computer. Using an uninterruptible power supply (UPS) to power the HDR24/96 is a good idea to avoid an unexpected shutdown and protect it from transient line voltages.

Warning!

Before applying power to the HDR24/96, make sure that the Voltage Selector switch next to the AC inlet jack on the rear panel is set to the line voltage used in your region. Powering-on the HDR24/96 with the Voltage Selector switch set incorrectly will cause an electrical and fire hazard that may result in irreparable damage to the unit.
I/O Cards & Cables

I/O cards are available in four different flavors and can be mixed and matched in any combination:

**AIO•8**
- Each AIO•8 provides 8 analog line-level inputs and outputs on two 25-pin D-subminiature (DB25) connectors. These connectors are pin-for-pin compatible with the analog (not TDIF) DB25 connectors found on the TASCAM DTRS recorders. DB25 cables that break out to XLR or 1/4” TRS connectors for mating with your console are readily available.

**DIO•8**
- Each DIO•8 provides 8 digital inputs and outputs in two formats:
  1. TASCAM Digital Interface (TDIF) provides 8 input and output channels of digital audio on a single DB25 connector. It requires a TASCAM PW-88D or equivalent TDIF-compatible cable.
  2. ADAT Optical provides 8 channels of digital audio on fiber-optic cable. Two optical cables are required for each card, one for inputs, the other for outputs. Both cables must connect to the same device, creating a closed loop.
  3. The DIO•8 also provides a TDIF word clock sync output for use with older TASCAM equipment.

**OPT•8**
- The OPT•8 is a low-cost, ADAT Optical-only version of the DIO•8 card. The previous ADAT information also applies to this card.

**PDI•8**
- Each PDI•8 carries four stereo pairs (eight channels) of digital input and output on a single DB25 connector. This card supports the AES/EBU (IEC-958 Type 1) digital interfacing standard carrying two channels of digital audio on a single balanced cable. The PDI•8 can also be configured for the consumer (IEC-958 Type 2, or S/PDIF) data format if required. DB25 cables that break out to XLR connectors, or double-ended DB25 to DB25 AES/EBU cables for mating with your console, are readily available.

Note: Different manufacturers use different wiring standards for DB25 interface cables (both analog and digital) that otherwise look the same. Make sure the cable you are using is the correct one. See Appendix A for a list of compatible HDR24/96 I/O card cables.
**To install the I/O cards:**

1. If the HDR 24/96 is plugged into AC power, unplug it.

2. Remove the I/O card slot cover plates by removing the rather tight top and bottom screws with a screwdriver.

3. Before you take I/O cards from their bags, touch a grounded metal object to discharge any static electricity from your body.

4. Remove the I/O card from its bag and hold it so that the component side faces left.

5. Line up the card so that the top and bottom edges slide smoothly into the white card guides. Push the card all the way in until its faceplate is flush with the back panel.

6. Hand-tighten the thumbscrews at the top and bottom of the card. Do not use a screwdriver.

   If you want to hook up the HDR 24/96 I/O cables to your console right now, see the console hookup diagrams in Hookups (page 20). Be sure to come right back here when you’re done.

**Note:** Always hand tighten the thumbscrews at the top and bottom of all I/O cards before operating the HDR 24/96.
Sync Card & Cable - Word Clock and Digital Synchronization

The Sync Card provides ports to synchronize the HDR24/96’s sample clock and time/transport position to other equipment. The functions of the jacks and switch, from top to bottom are:

- **SMPTE Input / Output** – This 1/4” TRS jack serves as an input when slaved to incoming SMPTE time code, and as an output when generating SMPTE time code to synchronize other devices with the HDR24/96.

- **Termination Switch** – This pushbutton switch selects the termination impedance of the Word Clock / Video Input jack. When the switch is out, the impedance is 10kΩ (bridging); when in, the impedance is 75Ω (terminated).

- **Word Clock / Video Input** – This BNC jack receives either word clock, composite video, or video blackburst as determined by the HDR24/96 Sample Clock source setting. Use this input when the HDR24/96 is operating as a word clock slave.

- **Word Clock Output** – This BNC jack transmits word clock to other devices in the system when the HDR24/96 is configured as the clock master.

Whenever digital audio devices are interconnected, the sample clock of every device must run at exactly the same rate. This is usually accomplished by selecting one device as the “master” clock source and distributing its word clock signal to all the “slave” devices in the system. The master is configured to run from its internal clock, and the slaves from external word clock. Some digital interfaces are self-clocking (such as the AES input on many DAT machines) and do not require a separate work clock connection. Others simply cannot be configured as slaves. The master/slave designation must be correctly made for each device to avoid the clicks and pops associated with asynchronous clocks.

SMPTE time code is used for time synchronization between the HDR24/96 and other devices such as a video cassette recorder or another audio recorder. Connect the jack to a time code input if the HDR24/96 is the master, or to a time code source if the HDR24/96 is to be the time code slave.

Generally it doesn’t matter which device in a system serves as the word clock master, except when synchronizing to time code or video. For example, if your HDR24/96 Inputs and Outputs are connected to the Tape Inputs and Outputs of a Mackie Digital 8•Bus console using TDIF, either the HDR24/96 or D8B can be the word clock master. However, if you later synchronize the HDR24/96 to time code from a VTR, you must lock the VTR and HDR24/96 to a master video sync source and lock the D8B (which can’t sync to video) to the word clock from the HDR24/96. In this case the HDR24/96 is both a video slave and a word clock master. For more detailed information on setups involving video and time code synchronization, see the Applications Manual.

**Note:** For audio-for-video applications, the HDR24/96 can lock its word clock to a video signal. In this configuration, there must be only one word clock dependent device (the HDR24/96) locked to the video source. The HDR24/96 then becomes the word clock master for the other digital devices in the system (for example, a digital mixing console). Do not attempt to lock multiple digital devices to the video signal, or you’ll get clicks.
The following are recommended setups for establishing proper sample clock synchronization with the devices connected to the HDR24/96 digital I/O cards.

**TDIF (DIO•8)**

With the HDR24/96 as a master, connect Word Clock Out of the HDR24/96 to Word Clock In on the receiving device(s). If connecting to older TASCAM DTRS recorders, use the Sync Out port on the first DIO•8 card instead of Word Clock Out. If there is more than one DTRS recorder in the chain, connect Sync Out to the word clock input of the first DTRS recorder only; the other recorders are synchronized through their interconnecting DTRS cables.

With the HDR24/96 operating as a slave to another TDIF device, connect the word clock output from the master TDIF device to Word Clock In on the HDR24/96.

**ADAT Optical (DIO•8, OPT•8)**

With the HDR24/96 as a master, set the receiving device(s) to derive sample clock from their ADAT Optical ports if the ports are self-clocking. In this case, no word clock connection is necessary. If the ADAT Optical ports on the receiving devices are not self-clocking, connect Word Clock Out of the HDR24/96 to Word Clock In on the receiving device(s).

With the HDR24/96 configured as a slave, connect the word clock out of the master ADAT Optical device to Word Clock In on the HDR24/96.

**AES/EBU (PDI•8)**

With the HDR24/96 as a master, set the receiving device(s) to derive their sample clock from the AES/EBU ports if the ports are self-clocking. In this instance, no word clock connection is necessary. If the AES/EBU ports on the receiving device(s) are not self-clocking, connect Word Clock Out of the HDR24/96 to Word Clock In on the receiving device(s).

With the HDR24/96 as a slave, connect the word clock out of the master AES/EBU device to Word Clock In on the HDR24/96.

---

**Note:** Use 75 Ω coaxial cables when connecting word clock or video to the Sync Card Word Clock/Video input jack. If the HDR24/96 is at the end of a cable that's connected to several devices, push the Termination Switch in; otherwise leave it out and use a BNC Tee adapter to feed the signal on to the next device in the chain.

**Note:** If you are using an HDR24/96 with the Mackie Digital 8•Bus console, you may need to turn on the Digital 8•Bus first. The Clock I/O on the DB8 prefers not to see an active signal at its Word Clock input when it powers up.
**Mackie Media (Optional)**

The HDR24/96 emulates the tape library tradition with Mackie Media M•90 and Mackie Media PROJECT drives. Both drives come complete with a plug-in tray for quick removal and a nifty storage case for shelving and transporting the drives. Trays can be purchased separately if you want to use your own UDMA IDE drives. The HDR24/96 can record or play directly off the M•90 so you can change sessions as quickly as changing tape on a 24-track – no backup time required. PROJECT drives are for backup only and use removable 2.2GB ORB cartridges that fit in your pocket. Each can hold a couple of 5-minute 24-track masters.

To install or remove a Mackie Media tray:

1. Power the HDR24/96 off whenever inserting or removing media trays. **If you have an active project, don't forget to save it first!**

2. To remove a drive, first unlock it by inserting the key and turning it a quarter-turn counterclockwise. Two keys are packed with the recorder, and one with each M•90 drive.

3. Lift the bail handle to release the drive, and pull it out of the drive bay.

4. To install a new M•90 or PROJECT drive, slide the media tray into the front panel drive bay. Press it firmly into place, and latch it by pressing the bail handle downward until it’s fully seated.

5. Insert the key into the lock and turn it a quarter-turn clockwise. The key locks the drive into place and powers the tray.

6. The HDR24/96 will automatically detect the Mackie Media drive when you next power it up.

**Note:** Mackie Media are hard drives, and as we all know, hard drives involve some pretty intricate technology. So don't shake the little darlin', and if a tray has just come in from a freezing car or airplane cargo hold, do not install it until it has reached room temperature.
Monitor / Mouse / Keyboard (Optional)

Most of the HDR24/96 editing features require a monitor, mouse and keyboard. Here’s how to install them:

1. Connect a color SVGA monitor to the HDR24/96 Video connector. The monitor should support a 1024x768 screen resolution at a 60 Hz vertical scan rate, and for the best picture, should have at least a 17” screen.

2. Connect a two-button PS/2 compatible mouse to the Mouse port.

3. Connect a PC-style keyboard to the Keyboard port. If your keyboard has a PS/2 style connector, you will also need a male 5-pin DIN to female PS/2 adapter, readily available at any computer store.

No special software configuration is required for these devices. On bootup, the HDR24/96 will automatically detect their presence and configure itself accordingly.
Note: If you are using an HDR24/96 with the Mackie Digital 8-Bus console, you may need to turn on the Digital 8-Bus first. The Clock I/O on the D8B prefers not to see an active signal at its Word Clock input when it powers up.

Remote 24 / Remote 48 Pro (Optional)
Installing either Remote is as simple as plugging in a telephone. Connect one end of the cable (supplied with the Remote) to the ‘REMOTE’ jack on HDR24/96 rear panel, and the other end to the ‘TO HDR REMOTE JACK’ jack on the Remote. It’s OK to plug or unplug either Remote with the HDR24/96 powered on.

Footswitch (Optional)
For hands-free do-it-yourself punches and other frequently-used functions like Play/Stop, New Cue, Take Select, and Next Cue, connect the cable of a momentary, normally open footswitch to the ‘FOOT SWITCH’ 1/4” TS jack on the rear panel of the HDR24/96, the Remote 24, or Remote 48 Pro. If you have a Remote installed you can connect two foot switches, one to the HDR24/96 and one to the Remote. Each footswitch functions independently of the other. Footswitch functionality is assigned in the front panel System menu or the GUI General Setup window. See the Reference Manual for more details.

Power-Up
OK, NOW you can turn it on. Assuming you have already connected the HDR24/96 to your console, power up the HDR24/96 first, then the outboard equipment and console, and finally the power amplifiers or powered monitors. Audio equipment tends to generate unexpected clicks and pops when you power it up, so by powering up your monitoring system last, you’ll save your speakers and your ears.

Before you read the next section, take a quick, self-guided tour of the front panel display and controls to get a sense of where they are.
Configuration
Before starting a Project, you will need to configure the HDR24/96 I/O card options and synchronization parameters. These parameters determine where the sample clock is coming from, how fast the sample clock runs, and how many bits are recorded in every sample. Some options, like sample rate and bit depth, will become “standards” that you won’t need to change very often. The remaining synchronization options (for time code and video) are covered in detail in the Applications and Reference Manuals.

I/O Cards
Only the DIO•8 and PDI•8 cards require special configuration. If you are using AIO•8 or OPT•8 cards only, you can skip to the next section.

DIO•8 Card
To set the DIO•8 input and output formats:

1. Press Digi I/O to enter the Digital I/O Card Setup screen.

2. Select In.

The Setup Tape Inputs screen shows you the current input settings for each of the three I/O cards.

3. Press the Select button corresponding to each DIO•8 card and toggle the selection between ADAT and TDIF.

4. Press the Page Left (<) button to return to the previous screen.

5. Now select Out.

The Setup Tape Outputs screen shows you the current output settings for each of the three I/O cards.

6. For each DIO•8 card present, press the Select button to select the desired output format. Or, select the TD->AD or AD->TD option to convert between formats, bypassing the HDR24/96 tape signal path entirely.

7. When done, press Digi I/O to exit the menu.

Note: The front panel display’s backlight switches off after several minutes of inactivity. It’ll come back on automatically when it’s needed to display new information, but you can revive it at any time by pressing either the Page Left [<<<<<] or Page Right [>>>>>] button below the display.
1. Select **Setup** from the Windows menu (or use keyboard shortcut **CTRL+1**) and click on the **Digital I/O** icon.

The Digital I/O Setup dialog shows you the current settings for each of the three I/O cards (see illustration below).

2. Click on the Input pulldown menu and select either **ADAT** or **TDIF** for each DIO•8 card.

3. Click on the Output pulldown menu and select the desired output format. Or, select the **TDIF→ADAT** or **ADAT→TDIF** option to convert between formats, bypassing the HDR24/96 tape signal path entirely.

4. Click the arrow in the top right corner of the dialog or hit **ESC** to exit.

---

**A Closer Look**

The input and output settings on the DIO•8 card need not be the same. For example, you can use outboard A/D converters with ADAT Optical outputs and a console with TDIF inputs without problems. Just remember to correctly set up Word Clock.
**PDI•8 Card**

The PDI•8 card options include sample rate conversion for each stereo AES/EBU input, and status bit control (pro/consumer mode) for each output. When a PDI•8 card is first installed, its default settings are for sample rate conversion *Off*, and channel status bits set to indicate the *Pro* (AES/EBU) format. In most circumstances you won’t need to change these settings. However, if the device(s) connected to the PDI•8 inputs cannot be made a clock master or slave (such as a CD player with a digital out), enabling sample rate conversion on each affected input will effectively re-clock the incoming data.

Occasionally you’ll run across a device that will not recognize the digital audio output from the PDI•8 card. Changing the status bits on the affected output(s) from *Pro* to *Consumer* (S/PDIF) may solve the problem.

Remember that with the AES/EBU format, channels come in pairs, so rather than eight settings, you have four, one for each pair of channels.

**To set the PDI•8 card options:**

1. Press **Digi I/O** to enter the Digital I/O Card Setup screen.

2. Select **Rate Convert**. The Sample Rate Convert screen shows you the Sample Rate Conversion settings for inputs 1-8.

3. Press the **Select** button corresponding to the desired input channel(s) and toggle the selection. **On** enables sample rate conversion, **Off** disables it (default).

4. Press the **Page Right** (>) button to scroll to channels 9-16. Repeat the procedure for channels 9-16 and 17-24. Press **Page Left** (<) until you return to the Digital I/O Card Setup screen.

5. Select **Stat Bits**. The Setup Status Bits screen shows you the current Status Bit settings for outputs 1-8.

6. Press the **Select** button corresponding to the desired output channel(s) to toggle the selection between *Pro* (default) and *Consu*.

7. Press the **Page Right** (>) button to scroll to channels 9-16. Repeat the procedure for channels 9-16 and 17-24. Press **Digi I/O** to exit.
1. Select **Setup** from the Windows menu (or use keyboard shortcut **CTRL+1**).

2. Click on the **Digital I/O** icon. For each PDI•8 card, click the **Setup** button. In the AES/EBU Setup dialog, check the **Converted** boxes corresponding to the desired input(s) to enable sample rate conversion; leave the boxes unchecked for no sample rate conversion (default).

3. Then select **Pro** (default) or **Consumer** from the pulldown menus associated with the desired output(s). Click the arrow in the top right corner of the dialog or hit **ESC** to exit.

**Note:** When sample rate conversion is active, the input signal is truncated to 20 bits, causing a slight degradation in the signal quality of a 24-bit input. Therefore sample rate conversion should be enabled only when intentionally converting a signal to a different sample rate (e.g. from 44.1k to 48k), or when no other means exist to establish clock synchronization with the device(s). See the Reference Manual for details.
**Synchronization**

**Sample Clock Source**

The Sample Clock setting determines the source of the HDR24/96 sample clock. If the HDR24/96 is a clock master or not connected to any other digital device(s), set it to **Internal**. If the HDR24/96 is a word clock slave, set it to **Word Clock**. A third option is **Video** and this is discussed in the Reference Manual.

**Sample Rate**

The Sample Rate determines how fast the HDR24/96 sample clock runs. Compact Disks use a **44.1 kHz** sample rate; the video production folks prefer **48 kHz** because their digital video recorders use 48 kHz.

**Bit-Depth**

The Bit Depth setting determines how many bits are contained in each audio sample recorded to disk (the bit “resolution”). While **16-Bit** audio takes up 1/3 less disk space than **24-Bit** audio, **24-Bit** audio offers the potential for greater dynamic range (the difference between the softest and loudest sounds that can be recorded) and captures a more accurate “image” of the sound.

**To configure the HDR24/96 Synchronization settings:**

1. Press **Sync** to enter the Sync Options menu. Select **Sample Clock**. Using the **- Dec / + Inc** or **<< / >>** buttons, select either **Internal** or **Word Clock** according to your setup. We’ll leave video sync for the Reference Manual.

2. Select **OK** to return to the Sync Options menu.

3. Select **Sample Rate**. Using the **- Dec / + Inc** buttons or **<< / >>** buttons, set the Sample Rate to **44.1 kHz** or **48 kHz**. Select **OK**.

4. Move to the next page of the Sync Options menu with the **Page Right (>)** button.

5. Select **Bit Depth**. Using the **- Dec / + Inc** or **<< / >>** buttons, set the Bit Depth to **16 Bit** or **24 Bit**. Select **OK**, then press the **Sync** button to exit the menu.
Hookups

This section shows how the HDR 24/96 is typically connected to either analog or digital consoles (using the Mackie Analog and Digital 8•Bus consoles as examples). These examples assume that the rest of your studio equipment (monitors, sound sources, outboard processing, etc.) is already connected, or that you know how to connect it.

Before you begin, note how the three eight-channel I/O cards are arranged on the HDR 24/96 rear panel: 1-8 is on the left, 9-16 is in the center, and 17-24 is on the right. Labeling cables before you begin will make connecting the HDR 24/96 to your console easier.

The specific hookups for each HDR 24/96 I/O card are shown below.

Analog Hookup (AIO•8)

This example describes the hookup for the 24•8 analog console.

Cables & Hardware

(3) AIO•8 cards for HDR
(6) Analog snakes, DB25 to eight 1/4" TRS phone plugs

Hookup

1. Connect three snakes to the HDR 24/96 Inputs (bottom connector). If you want to have the ability to route any console input to any recorder track, then connect the 1/4" plugs on each of the three snakes to the like-numbered Submaster / Tape Output jacks on the 8•Bus console. This works as long as you don’t record more than 8-channels at a time, since the Submaster Outputs 9-16 and 17-24 are the same as outputs 1-8.

Alternately, you can connect the console’s direct outputs to the recorder’s inputs, so that each console channel feeds the like-numbered recorder track. Or, you can use a combination of direct and subgroup outs. The hookup diagram below shows the HDR 24/96 inputs connected to the Submaster Outputs. See the Applications Manual for additional tips.
This example describes the hookup for the D8B console equipped for analog I/O.

Cables & Hardware
(3) AIO•8 cards for HDR24/96
(3) AIO•8 cards for D8B
(6) DB25 to DB25 analog snakes

Hookup
1. Connect three snakes between the HDR24/96 Inputs (bottom connector) and the corresponding D8B Tape Outputs (top connector).
2. Connect three snakes between the HDR24/96 Outputs (top connector) and the corresponding D8B Tape Inputs (bottom connector).

HDR24/96 Settings
1. Set the Sample Clock to Internal.
2. Set the Sample Rate and Bit Depth according to your preference. It is not necessary to set the D8B and HDR24/96 to the same Sample Rate, since with analog connections, the sample clocks on the two units are not synchronized.

Console Settings
1. Set the D8B Sample Clock to 44.1 k Internal or 48 k Internal according to your preference.
TDIF Hookup (DIO•8)

Cables & Hardware
- (3) DIO•8 cards for HDR24/96
- (3) DIO•8 cards for D8B
- (1) Clock I/O card for D8B
- (3) TDIF cables
- (1) 75 Ω BNC word clock cable

Hookup
1. Connect the three TDIF cables between the corresponding TDIF jacks on the HDR24/96 and D8B.

2. When TDIF is used, the D8B must have a Clock I/O card installed. To make the D8B the clock master, connect its Word Clock Out (not DIO•8 Sync out) to the HDR24/96 Word Clock In. To make the HDR24/96 the clock master, connect its Word Clock Out to the D8B Word Clock In. See Figure 1.

HDR24/96 Settings
1. Set the Tape Input format for each DIO•8 card to TDIF, and the Tape Output format to TDIF.

2. If the HDR24/96 is the clock master, set the Sample Clock to Internal; if it is a clock slave, set it to Word Clock and depress the 75 Ω termination switch on the Sync card.

3. Set the Sample Rate to 44.1 kHz or 48 kHz according to your preference.

Console Settings
1. Set the Tape Input and Tape Output format for each DIO•8 card to TDIF.

2. If the D8B is the clock master, set the Sample Clock to either 44.1 k Internal or 48 k Internal; if it is a clock slave, set the Sample Clock to either 44.1 kHz or 48 kHz. Set the Sample Rate to match the Sample Rate selected on the HDR24/96.
TDIF Hookup with DIO•8

Note:
The Word Clock connections shown here are the same for Figure 2, 3 and 4
ADAT Optical Hookup (DIO•8 or OPT•8)

Cables & Hardware
(3) DIO•8 or OPT•8 cards for HDR 24/96
(3) DIO•8 or OPT•8 cards for D8B
(1) Clock I/O card for D8B
(6) ADAT Optical cables
(1) 75Ω BNC word clock cable

Hookup
1. Connect three ADAT Optical cables from the HDR 24/96 Optical Outputs to the Optical Inputs on the corresponding D8B I/O cards.

2. Connect three ADAT Optical cables from the HDR 24/96 Optical Inputs to the Optical Outputs on the corresponding D8B I/O cards.

3. When ADAT Optical is used, the D8B must have a Clock I/O card installed. To make the D8B the clock master, connect its Word Clock Out to the HDR 24/96 Word Clock In. To make the HDR 24/96 the clock master, connect its Word Clock Out to the D8B Word Clock In.

HDR24/96 Settings
1. If you have DIO•8 cards installed, set the Tape Input and Tape Output format for each card to **ADAT**. OPT•8 cards need no configuration.

2. If the HDR 24/96 is the clock master, set the **Sample Clock** to **Internal**; if the HDR 24/96 is a clock slave, set the **Sample Clock** to **Word Clock** and depress the 75Ω termination button on the Sync card.

3. Set the **Sample Rate** to 44.1 kHz or 48 kHz according to your preference.

Console Settings
1. If you have DIO•8 cards installed, set the Tape Input and Tape Output format for each card to **ADAT**. OPT•8 cards need no configuration.

2. If the D8B is the clock master, set the **Sample Clock** to either **44.1 k Internal** or **48 k Internal**; if it is a clock slave, then set the **Sample Clock** to either **44.1 kHz** or **48 kHz**. Set the Sample Rate to match the **Sample Rate** selected on the HDR 24/96.
ADAT Optical Hookup with DIO•8

Depress the Termination button if the HDR24/96 is set to Slave.

Use one only.

Figure 2
ADAT Optical Hookup with OPT•8

Use one only

Depress the Termination button if the HDR24/96 is set to Slave

Figure 3
AES/EBU Hookup (PDI•8)

Cables & Hardware
(3) PDI•8 cards for HDR24/96
(3) PDI•8 cards for D8B
(1) Clock I/O card for D8B
(3) DB25 to DB25 AES/EBU snakes
(1) 75Ω BNC word clock cable

Hookup
1. Connect the three AES/EBU cables between the corresponding AES/EBU connectors on the HDR24/96 and D8B.
2. When AES/EBU is used, the D8B must have a Clock I/O card installed. To make the D8B the clock master, connect its Word Clock Out to the HDR24/96 Word Clock In. To make the HDR24/96 the master, connect its Word Clock Out to the D8B Word Clock In.

HDR24/96 Settings
1. If the HDR24/96 is the clock master, set the Sample Clock to Internal; if it is a clock slave, set the Sample Clock to Word Clock and depress the 75Ω termination switch on the Sync card.
2. Set the Sample Rate to 44.1 kHz or 48 kHz according to your preference.

Console Settings
1. If the D8B is the clock master, set the Sample Clock to either 44.1 k Internal or 48 k Internal; if it is a clock slave, set the Sample Clock to either 44.1 kHz or 48 kHz. Set the sample rate to match the Sample Rate selected on the HDR24/96.

OK, so we fibbed a little. You can use PDI•8 cards in the D8B without a Clock I/O card installed, but doing so requires that you enable sample rate conversion on both the D8B and the HDR24/96 in lieu of word clock synchronization. Sample rate conversion results in a 4-bit loss in sample resolution that may degrade the quality of the sound slightly. So, the moral of the story is that unless you just blew your wad on a new guitar and are eating peanut butter sandwiches until your next paycheck, go buy a Clock I/O card.
AES/EBU Hookup with PDI•8

Depress the Termination button if the HDR24/96 is set to Slave.
HDR24/96 Operation

Now that you’ve finished installing and configuring the HDR24/96, you’re almost ready to start your first Project. We still want you to read this entire guide, but we already hear some of you shuffling and muttering. Okay, okay, okay... for the terminally impatient, read this chapter, then you can go out and play with your friends.

This section explains all you need to know to run a basic recording session: opening and creating Projects, operating the Transport, setting levels, and recording and overdubbing tracks. After you’re done recording, you will learn how to back up your project to Mackie Media M•90 and Mackie Media PROJECT drives.

Because this section just scratches the surface of the HDR24/96’s feature set, we strongly recommend going through the Applications and Reference Manuals to learn about advanced HDR24/96 features like Playlists, Virtual Takes, GUI editing, FTP file transfer, synchronization, and more.

Opening Projects

The HDR24/96 organizes audio files and session information into folders called Projects. When the HDR24/96 boots up, it automatically opens the last Project you worked on. We’ve included two demonstration Projects, Ode to Masters and Little Love, to help you get familiar with the HDR24/96 right out of the box. At this point, you should see the name of the demo Project in the LCD display and above the Current Time display in the GUI.

To open a Project

1. Press Project. In the Project Files Menu, select Open. Use the - Dec / + Inc or the << / >> buttons to select the desired Project.
2. Select Open.

1. Select Open Project from the File menu (or use keyboard shortcut CTRL+O).
2. In the Open Project dialog box, click on the desired Project name, then click Open, or simply double click the Project name.
Basic Transport Operations

The HDR24/96 transport and recording controls are similar to those on most multitrack tape recorders.

Play

Play puts the HDR24/96 into play from any state (as if you didn’t know). Play also punches out of record and cancels master record standby while leaving the Transport in play.

To put the Transport into play:

- Press Play.
- Click Play.
- Press the Spacebar when the Transport is stopped.

Fast Wind

Rewind and Fast Forward put the HDR24/96 into fast wind mode from any state. They behave just like those on a large multitrack recorder – when pressed from stop, the “tape” rolls slowly at first, then accelerates to 20X speed in a few seconds. Pressing either button a second or third time increases the winding speed.

To put the Transport into fast wind:

- Press Rewind or Fast Forward one, two, or three times.
- Click Rewind or Fast Forward one, two, or three times.
- Press SHIFT+< or SHIFT+> one, two, or three times.

Stop

Stop brings the “tape” to an immediate halt. Stop also punches out of record and cancels master record standby.

To stop the Transport:

- Press Stop.
- Click Stop.
- Press the Spacebar when the Transport is moving (either playing, recording, or winding).
Time Displays

The Current Time display shows the exact position of the HDR24/96’s “playback head.” In the GUI, Current Time is represented both by an eight digit numeric display in the top right corner and by a vertical yellow line called the Time Line.

The time format can be displayed in the GUI as SMPTE (HH:MM:SS:Frames), Bars Beats Ticks (BBT), Milliseconds (HH:MM:SS:mmm), or Samples. The front panel displays only SMPTE or BBT time formats. It displays SMPTE time when Milliseconds or Samples is selected.

To change the Current Time:

- Use the Transport Play, Rewind, Fast Forward or Loc buttons.
- Use the Loc button, recall a Cue (see Cues on page 34) or click anywhere on the Time Bar when the Transport is stopped.

To change the time in any GUI time display (including Current Time):

- Click in the time display and drag the mouse up or down to increment or decrement the value; click outside the display to make the new time active.
- Click in the time display and type a specific time. TAB or SHIFT+TAB to move between fields; hit ENTER to make the new time active.

To change the Time Units:

- Right-click on the Time Bar or in any time display (except in the Cue List and the Setup window), and select one of the four options from the Time Units pop-up menu.
- Just in case you were looking - you can only switch the Time Units from the GUI.
Locate Points and Looping

Locate points provide fast access to frequently used locations in your Project. The HDR24/96 has four numbered Locates and a Transport Locate. The Transport Locate is a single point accessible only from the GUI. The numbered Locates can be set either from the front panel, Remote, or GUI, but can be recalled only from the front panel or a Remote. Storing a Locate point saves the Current Time (Transport position) to the Locate button. Recalling a Locate causes the Transport to jump to the stored time. If you want to mark lots of points in your project, use Cues (see Cues on page 34).

To recall a Locate point:

- Press Loc 1 or Loc 2 to jump to that point.
- Click Loc to jump to the Transport Locate point.

Note: You can’t jump to the four numbered Locate points from the GUI.

To store numbered Locate points:

Locate points can be stored either on the fly or when stopped.

1. Press Store. The Store light will blink to indicate that the HDR24/96 is ready to save a Locate point.

2. Press Loc1 or Loc 2 when the Transport is at the desired time; the Store light will go out, indicating that the point has been stored.

- When the Transport is at the desired time, press CTRL (the cursor will turn into a hand). Click anywhere inside the numbered Loc time display to transfer the current time to the Loc point.
- Enter the desired time directly into the numbered Locate time display with the mouse or keyboard (see Time Displays on page 31).

To set the Transport Locate point:

1. Click on the List View arrow to expand the List View.

2. Click on the Cues tab (or use keyboard shortcut CTRL+5). Enter the desired time directly into the Locate time display with the mouse or keyboard (see Time Displays). Or, when the Transport is at the desired time, click Set Loc, or CTRL+click inside the Locate time display.

- Press CTRL+L when the Transport is at the desired time.
Locates 1 and 2 double as start and end points for looped playback. When looping is enabled, playback cycles between the Loop Start and Loop End points. The order of the Loop points does not matter. If Current Time is outside the Loop points when playback starts, the transport jumps to the Loop Start point; if it is between the Loop points, playback starts from the Current Time.

To enable Looping:
1. Press Loop 1-2 to enable looping.
2. Press Play to start loop playback.

Whenever Loop is enabled, two blue Loop markers appear in the Marker Bar, indicating the loop start and end points.

To adjust the Loop Start and Loop End markers (Locates 1 and 2):
- With Loop enabled, drag the Loop Marker in the Marker Bar to the desired time.
Cues

Like Locates, Cues mark frequently used locations in your Project. However, Cues are available only from the GUI. The HDR24/96 provides up to 99 namable Cues that are visible in both the Cue List and the Marker Bar. Click on a Cue to select it for editing.

To create, edit and recall Cues from the Cue List:

- Click on the List View arrow and click on the Cues tab (or use keyboard shortcut CTRL+5).

Create a new Cue

- Click New when the Transport is at the desired time.

Store new Time to an existing Cue

- Click Store when the Transport is at the desired time to replace the selected Cue's time with the current Transport time.

Jump to a Cue

- Double-click on a Cue number.

Rename a Cue

- Double-click on the Cue name to rename the Cue to something more meaningful (like Guitar Solo). Type in the new name and hit ENTER or click outside the name field when done.
Move a Cue

- Double-click on the Cue time and enter a new value into the Cue time display with the mouse or keyboard (see Time Displays on page 31).

or:
- Drag the Cue marker in the Marker Bar.

Delete a Cue

- Select a Cue and then click Delete.

Like Locates, Cues can also be stored on the fly or when stopped. For convenience, the numeric keypad can be used to manipulate Cues.

To create, edit and recall Cues from the Keyboard:

Jump to Cues 0 through 99

- Type the cue number as two digits (Cue 5 is entered as 05) and press Enter.

Jump to next/previous Cue

- Press the – or + key to jump to the Cue that lies (chronologically) just before or after the current Transport position.

Create a new Cue

- Cues can be set on the fly, while recording or playing back. Press CTRL+M when the Transport is at the desired time. The new Cue is automatically assigned the lowest number available in the Cue List. Be aware that vacant numbers get re-used when adding new Cues, possibly creating some confusing chronology (try saying that ten times rapidly).

Create a new Cue at a specific Cue number

- Type the Cue number, then press * on the numeric keypad. When the Transport is at the desired time, press Enter to write the Cue. Manually entered Cue numbers need not be consecutive. For example, you may wish to number all your vocal cues in the 30's, your choruses in the 40's, and your guitar solos in the 50's.

Store new time to an existing Cue

- Type the Cue number, then press *. When the Transport is at the desired time, press ENTER.
Creating Projects

Now that you have a few basics down, you’re ready to start recording. First, you’ll need to create a new Project. Typically a Project is a song, radio spot, or sound effects stem for a 10-minute film reel, but it could also be a live concert or an entire symphony.

To create a new Project from the front panel:

1. Press Disk Util. The Disk Utility Menu displays the Active Drive, which is the drive on which new Projects will be created.

2. If you want to create a new Project on a different drive, select Set. In the Set Active Drive menu, use either the (–) Dec / (+) Inc or << / >> buttons to select either Internal or External. Select OK to confirm, then press Disk Util to exit. Otherwise, just press Disk Util to exit.

3. Press Project, then select New. The HDR24/96 asks if you want to save the currently open Project. Press No to discard changes you may have made to the demo Project to keep it intact for use with the tutorial in the Applications Manual.

4. The name “Project#1” appears on the left side of the LCD screen. A pointer (“v”) appears above the first character of the name to indicate that you can change that character. Press the (–) Dec / (+) Inc buttons to select the character you want in that position. Select the >> button to move the pointer to the next character.

5. When you’ve completed the Project name, select New to create the Project and exit.

The HDR24/96 will not allow you to type the following characters into the Project, Track, Take, and Playlist names: / \ : * “ ” < > |. They are reserved for use by the system.
To create a new Project from the GUI:

1. From the File menu select New Project or use the keyboard shortcut CTRL+N. The HDR24/96 will ask if you want to save the currently open Project.

2. Click No to discard the changes you made to the demo project and keep it intact for use with the tutorial.

3. In the New Project dialog box, select the drive you want to create the project on from the Drive Select pulldown menu, then type in the project name.

4. Click New.

Your new project is now open; the Active Drive, Project Name, and Playlist Name are shown in the LCD display and in the GUI above the Current Time display.

A Playlist is the part of a Project that keeps tracks of all your recording and editing, and controls what you hear when you hit Play. The HDR24/96 track display is the visual representation of the Playlist.

A Project can contain any number of Playlists. Since the audio recorded in one Playlist can be used in any Playlist, you can create multiple versions of the same song without affecting the original recording. For example, you can create dance and extended play mixes from a CD mix. Or, you can build an entirely new song and borrow parts from other Playlists. See the Reference Manual to learn more about Playlists.
**Naming Tracks**

Recorded audio files inherit the name of the track they are recorded on. The default names are Track 1, Track 2, etc. By giving your tracks meaningful names, managing your project and your audio files becomes much easier.

**To name Tracks:**

1. Double-click on a Track Name to highlight it. Type in a new track name of 12 characters or less.
2. Hit **TAB** or **SHIFT+TAB** to move to the next/previous Track Name field.
3. Press **ENTER** or click outside the Track Name when done.

**Monitoring**

The Monitor Mode buttons determine what you hear from the HDR 24/96 Tape Outputs. The HDR 24/96 offers several familiar track monitoring modes to facilitate rehearsal, tracking, and overdubbing.

**All Input**

All Input is used for rehearsal and level setting. When All Input is on, both armed and unarmed tracks monitor their inputs, and the Auto Input setting has no effect.

**To enable All Input:**

- Press the **All Input** button and the glowing LED above the button will indicate it is on.
- Click the **All Input** button at the bottom left of the display, or select **All Input** from the Transport pull-down menu.
**Auto Input**

Auto Input is used for recording. Auto Input affects only tracks that are in Record Ready ("armed"). Tracks that are not armed only monitor the playback of previously recorded audio. To use Auto Input mode, All Input must be turned off.

When Auto Input is On, armed tracks monitor their inputs in Stop, Fast Forward, Rewind, and Record. In Play, you hear only what’s already recorded on the tracks. This mode is used primarily for tracking and overdubbing, where you want to hear what’s been previously recorded on the track until the punch-in and after the punch-out. During the punch, you hear what is presently being recorded. Auto Input On is the default mode when you power up the HDR 24/96, and is the handiest mode for most people most of the time.

When Auto Input is Off, armed tracks always monitor their inputs. This mode is used primarily for rehearsal and tracking, where you want to always hear what you’re playing rather than what’s already recorded on that track.

**To enable Auto Input:**

- Press the **Auto Input** button. The glowing LED above the button indicates that it’s ON.

- Click the **Auto Input** button at the bottom right of the display, or select **Auto Input** from the Transport pulldown menu.
Metering and Setting Record Levels

A professional analog recorder has meters that indicate 0 VU at a +4 dBu nominal signal level. Generally you can record peaks 10 to 15 dB above that before distortion becomes objectionable. This 10-15 dB range above the nominal level is called “headroom.”

On digital recorder meters, zero represents the full-scale digital signal level, 0 dBFS for short. 0 dBFS is the hottest signal that a digital device can handle, with no headroom to spare. When a digital signal reaches 0 dBFS for more than a sample or two, the resulting distortion is uglier than scraping your fingernails across a chalkboard.

The front panel meters are always available. In the GUI, the Meters panel space is shared with the the Tools panel. To switch displays, click on the Tools or Meters tab along the top right edge of the screen.

Remember, audio levels must NEVER reach 0 dBFS... never, ever, ever. Digital clipping is an extremely nasty sound that could only pass for music if you like what those crazy kids listen to over and over at all hours of the nights.

To get the get the best sound from the HDR24/96:

1. Turn All Input on.

2. Ask the talent to play or sing as loud as they will be performing during the session. While watching the HDR24/96 meters, adjust the console's tape outputs so that the signal peaks cause the red overload indicators to come on occasionally. Then, back off the tape output level slightly. This insures the best fidelity and the widest dynamic range in the recorded signal and leaves you a little headroom to accommodate the talent’s enthusiasm. Keep the signal levels as high as possible without overload, because recording at lower levels reduces resolution and dynamic range. Nonetheless it is always better to be conservative and avoid the risk of overload than to try squeezing the last ounce of dynamic range from the signal.
3. Alternately, if you have a tone generator or a sound source with a constant volume (you can hold down a key on a synth), turn All Input on and send the tone to all 24 tracks of the console. Adjust the output levels to read 0 VU on analog consoles, or around -20 dBFS on digital consoles. If the HDR24/96 meters read -15 to -20, you’re in good shape. This leaves enough headroom for most popular music, but if you’re recording acoustic music, jazz, classical, or narration, you may want to leave a little more. When the talent starts to play you may have to make some final tweaks to get everything just right.

4. After adjusting the tape output levels for each console channel, follow your console manufacturer’s instructions for setting the console tape return levels.

The overload indicators on the HDR24/96 light when the signal level reaches -1 dBFS. In the GUI, the white track number above the Meters flashes red continuously when the signal on that track clips (reaches 0 dBFS). If the tracks Clip Indicator is lit, then turn down the console tape output to that track a bit.

**To clear the Clip Indicator:**

- Press Play.

- Click on the flashing track number, or click Play.

With analog I/O, a +22 dBu signal at the HDR24/96 inputs and outputs corresponds to 0 dBFS inside the HDR24/96. So, if your console has a nominal output level (0 VU) of +4 dBu, there is 18 dB of headroom before you hit the maximum record level on the HDR24/96. It also means that your console must be capable of putting out at least +22 dBu without distortion so the console doesn’t clip while the recorder is still within its working range. Most professional consoles can output +22 dBu without breaking a sweat (like the Mackie Analog and Digital 8•Bus consoles). But beware that semi-pro consoles often operate at a nominal output level of -10dBV and will run out of steam before reaching a level that can take advantage of the recorder’s full resolution.
**Recording**

All recording in the HDR24/96 is non-destructive. When you record over existing audio, the old audio is not “erased” as it with magnetic tape; rather, new audio files are created in addition to the existing files.

Recording can only take place on tracks that are “armed” for recording.

**To arm tracks for recording:**

1. Press a track’s **Record Ready** button to arm the track.

2. Press it again to disarm the track.

1. Click a track’s **Record Ready** button to arm the track.

2. Click it again to disarm the track. Click and drag across several **Record Ready** buttons to arm a range of tracks.

The **Record Ready** LED/button blinks when a track is armed and ready to record, and glows when the track is recording.

**To record:**

1. Arm one or more tracks.

2. Click **Record**.

3. Click any transport button other than **Record** to stop recording.

1. Arm one or more tracks.

2. Press **Play** and **Record** simultaneously.

3. Press any Transport button other than **Record** to stop recording.

The Record LED glows when the HDR 24/96 is recording and blinks when **Record** is engaged with no tracks armed (master record standby mode). Pressing **Play + Record** together is a holdover from analog tape days to prevent you from accidentally erasing the tape (and making the producer really, really upset) with an inadvertent button press. But since recording with the HDR 24/96 is always non-destructive, there is never a danger of accidental erasure! So, to save wear and tear on your fingers, the HDR 24/96 offers the option of One Button Punch. One Button Punch affects only front panel and Remote operation, but not the GUI.

**To enable One Button Punch:**

- Select **One Button Punch** from the Transport pulldown menu. **One Button Punch** remains enabled until you de-select it again from the Transport menu.
To record with One Button Punch enabled:

- From Play, Press **Record**; there is no need to hold **Play** to start recording. Press any Transport button other than **Record** to stop recording.

When **Record** is engaged, you can punch in and out of record on individual tracks using the **Record Ready** buttons. All of the recording methods sound the same, with no clicks or gaps. Arming tracks before pressing **Record** is usually the best way to work when tracking, while pressing **Record** with no tracks armed (Master Record) and then punching with the **Record Ready** buttons is a handy way to overdub individual tracks.

**Record Safe** disarms all tracks and disables all recording controls while it remains engaged.

To engage Record Safe:

- Press **Rec Safe**.
- Select **Record Safe** from the Transport pulldown menu.
**Autopunch**

Autopunch allows you to automatically punch in and out between two predefined points. This feature is very convenient when you need to nail really a tight punch or need two hands to play your instrument. Numbered Locates 3 and 4 (available on the GUI and the Remotes but not the front panel), double as the Autopunch Punch In and Punch Out points.

**To enable Autopunch:**
- Click the **Punch** button.

When **Punch** is enabled, two red Punch markers appear in the Marker Bar.

**To adjust the Punch In and Punch Out markers (Locates 3 and 4):**
- When the Transport is at the desired time, **CTRL+click** (the cursor will turn into a hand) inside the numbered Locate time display. Or, when **Punch** is enabled, drag the Punch Marker in the Marker Bar to the desired time.

or:
- Enter the desired time directly into the numbered Locate time display with the mouse or keyboard (see **Time Displays** on page 31).

**To perform Autopunch recording:**

1. Arm one or more Tracks, and park the transport comfortably before the Punch In point. You could use **Loc 1**, **Loc 2**, or the Transport Locate point to get there quickly.

2. Press **Play** and **Record**.

The Record LED blinks and the HDR24/96 plays. When Current Time reaches the Punch In point, the HDR24/96 begins recording on all armed tracks and the Record LED glows. When Current Time reaches the Punch Out point, the HDR24/96 stops recording, the Record LED blinks, and the HDR24/96 continues playing. The order of the Punch points does not matter; the punch in always happens at the earlier point, and the punch out at the later point.

**Use Loop and Autopunch together to do looped Autopunch recording. In this mode, your punch-in point must be no closer than 3 seconds to the loop start point. The loop end point must be at least 3 seconds later than the punch-out point.**
Footswitch Operation

Using a footswitch with the HDR 24/96 gives you hands-free access to several of the most-used HDR 24/96 functions. The footswitch is extremely handy when you want to use your hands for other tasks, like playing your instrument, working the console, or eating pizza. Punching in and out is probably the most common use of the footswitch, but it can do other tricks as well.

**Punch** punches-in just like pressing Play+Record and punches-out like hitting Play. When playing, hitting the footswitch punches-in on all armed tracks. When recording, hitting the footswitch again punches-out of Record, but leaves the transport in Play.

**Stop/Play** acts just like the SPACEBAR on the keyboard. When the Transport is stopped, it puts it into play; when moving, it stops the Transport.

**Next Cue** acts just like the + key on the numeric keypad and locates the Transport to the next chronological Cue in the Project. When the Transport is located on or after the last Cue, it locates back to the first Cue.

**New Cue** creates a new Cue. The Cue is automatically assigned the lowest number available in the Cue List.

To assign the footswitch function:

1. Press the **System** button. In the System menu, select **Footswitch HDR**. Then select **Punch, Stop/Play, Next Cue, or New Cue** from the HDR Footswitch mode menu.
2. Select OK, and press **System** again to exit.

1. Select **Setup** from the Windows menu (or use keyboard shortcut **CTRL+1**) and click on the **General** icon.
2. Select **Punch, Stop/Play, Next Cue, or New Cue** from the Footswitch pulldown menu.
3. Click the arrow in the top right corner of the dialog or hit **ESC** to exit.
Delete Last

With the HDR24/96 you don’t need to worry about filling up your hard disks with unwanted takes. The Delete Last function erases all the audio files recorded during the last record pass. A recording pass consists of all punches made within one play/stop cycle.

To Delete Last recording pass:

- Press the Delete Last button. The LCD display will ask you to confirm that you want to delete the last record pass. Press OK.

1. Click on the List View arrow to expand the List View.
2. Click on the History tab (or use the keyboard shortcut CTRL+6).
3. Scroll down to the bottom of the list and search upwards for the last Record Pass entry.
4. Click on the entry just above it. The Undo Record Pass dialog will appear and ask you to confirm the deletion.
5. Click Yes.

Alternate method:

1. Select Undo Record Pass from the Edit menu immediately after recording (or use the keyboard shortcut CTRL+Z). The Undo Record Pass dialog box will appear and ask you to confirm the deletion.
2. Click Yes.

Saving Projects

Every time you record new audio, the audio data and Project information is automatically saved to disk. However, if you make other changes to the Project (naming tracks, setting markers, edits, etc.) without recording new audio, you must save the Project for these changes to be remembered. In other words, if you quit without saving, no audio is lost, but your changes will be. So once you start editing, save often.

To save the current Project:

1. Press the Project button.
2. From the Project Files menu select Save.
3. Press the Project or Page Left (<) button again to exit.

or:

- Select Save Project from the pulldown File menu.

or:

- Use the CTRL+S keyboard shortcut.
Project Backup / Restore

With Mackie Media drives, you can back up your Projects on removable media that you can hand to the client or store in your tape library. Backing up and restoring Projects is as simple as copying the Projects between the internal and the Mackie Media drives.

To copy Projects between the internal and Mackie Media drives:

1. Press the Backup button.

2. Using the - Dec / + Inc or the << / >> buttons, select Set Source to set the drive the Project will be copied from, and Set Dest to set the drive the Project will be copied to. Since a Project can't be copied onto itself, the Source and Destination drives must be different.

3. Select OK to return to the Backup menu, then select Backup. Choose the desired Project using the (-) Dec / (+) Inc or the << / >> buttons.

4. Press OK. When the backup is completed, either select another Project to back up or press the Backup button to exit.

1. Select Project Manager from the File menu, or use the CTRL+B keyboard shortcut. The Project Manager dialog box displays two columns listing all of the Projects on each drive.

2. Click on the Project you want to copy. You can use CTRL+click to select multiple Projects or SHIFT+click to select a contiguous range of Projects.

3. Click the Copy arrow or drag the selected Project(s) across to the opposite column. Click the small arrow in the top right corner of the dialog box or hit ESC to exit.
It is extremely important that you make backup copies of your projects at the end of each session. While digital recording technology is highly reliable and hard disk media is durable, sometimes stuff just happens. To reduce your risk of catastrophic data loss (and the possible loss of $$ and clients), back up your projects on two media before deleting them from your working drive(s).

There... now you know better. So, don’t wait until disaster strikes to get backup fever, and don’t complain to Mackie when your pet Rottweiler discovers that the only copy of your client’s $20,000 project makes a superb chew toy and buries it in the garden.

All media must be formatted before it can be used with the HDR24/96. Formatting erases the media’s contents and prepares the file system for use with the HDR24/96. Mackie Media M•90 drives come pre-formatted and ready to use, as do ORB disks for the Mackie Media PROJECT drive (be sure to buy IBM formatted ORB disks). Most off-the-shelf UDMA IDE drives do not come pre-formatted.

Although you can use almost any IDE drive for backup, not all UDMA IDE drives are fast enough to be used for recording and playback. If you want to use your own UDMA IDE drive for recording and playback, you must format it with the HDR, then verify that it is fast enough to record and playback at the maximum data rate (24 track, 24-bit, 48 kHz). If the drive passes the performance verification test, it is “tagged” as a real-time drive. If it fails, then the drive can be used only for backup. External drives that fail the record verification test will appear with an asterisk (*) in the GUI and front panel menus and dialogs.

To format and verify media performance from the HDR24/96:

1. Press the **Disk Util** button. If the Active drive is not the external drive, then select **Set**.

2. In the Set Active Drive menu, use either the **Dec** / **Inc** or **<<** / **>>** buttons and select **External** (Mackie Media bay).

3. Select **OK**. Now select **Format**. The LCD screen will display a message asking you to confirm the format operation.

4. Select **OK**. When the format operation has completed, another message will appear asking you to verify the drive speed for recording and playback.

5. If a UDMA drive is installed, select **OK**. After the performance verification is completed, select **Continue**. If a Mackie Media PROJECT drive is installed, select **Cancel**; they are too slow to be used for recording and playback.

6. Press **Disk Util** to exit.
1. Select **Set Active Drive** from the File menu.

2. Select **External**.

3. Select **Format Drive** from the File menu and click **OK** in the Format Drive confirmation dialog box.

4. When the format operation has completed, another message will appear asking you to verify the drive speed for recording and playback. If a UDMA drive is installed, select **OK**. After the performance verification is completed, select **Continue**. If a Mackie Media PROJECT drive is installed, select **Cancel**; they are too slow to be used for recording and playback. **NOTE**: You cannot format the internal drive.

Some UDMA drives cannot keep up with the demand for 24 tracks of audio data. So, before you rush to your local computer store and buy the cheapest UDMA drive you can find, consider picking up some Mackie Media drives from your nearest Mackie dealer instead (nudge nudge, say no more...). If you still insist on the do-it-yourself route, check Mackie’s web site for a list of approved drives.

There! You’re all boned up on the HDR 24/96, so put down this booklet and get to work … or play. Thanks for reading this guide. If questions have gone unanswered, check the Applications and Reference Manuals or Mackie’s website www.mackie.com. Enjoy!
Appendix A: Compatible Cables

Analog and Digital Multitrack Cables

The following companies supply analog and digital multitrack cables for use with the HDR24/96 I/O cards:

Horizon Music, Inc.

P.O. Box 1988, Cape Girardeau MO 63702-1988
Tel: (800) 255-9822; Fax: (800) 455-3460
http://www.horizonmusic.com

AIO•8 Analog Interface Cables
HDA8 Series
DB25 to [specify connector]
Connector options: 8 male XLR, 8 female XLR, or 8 1/4” TRS
Standard lengths: 5, 10, 15, 20, 25 feet

DIO•8 TDIF Interface Cables
TDIF Series
DB25 to DB25
Standard lengths: 5, 10, 15 feet

PDI•8 AES/EBU Interface Cables
HD44 Series
DB25 to [specify connector]
Connector options: 4 male + 4 female XLR, or DB25
Standard lengths: 5, 10, 15, 20, 25 feet

Hosa Technology, Inc.

6920 Hermosa Circle, Buena Park CA 90620
Tel: (714) 736-9270; Fax (714) 522-4540
http://www.hosatech.com

AIO•8 Analog Interface Cables
DTP Series
DB25 to 8 1/4” TRS
DTF Series
DB25 to 8 female XLR’s
DTM Series
DB25 to 8 male XLR’s
Standard lengths: 3, 4, 5, 7 meters

DIO•8 TDIF Interface Cables
DBK Series
DB25 to DB25
Standard lengths: 3, 15 feet

OPT•8 / DIO•8 ADAT Optical Interface Cables
OPT Series
Standard ADAT Optical cables
OPM Series
Jacketed ADAT Optical cables w/ metal headshell
OPT lengths: 2, 3, 6, 10, 13, 17, 30, 50 feet
OPM lengths: 3, 5, 10, 15, 20, 30, 50 feet

PDI•8 AES/EBU Interface Cables
DBK Series
DB25 to 4 male, 4 female XLR’s
Standard length: 8 meters only
Marshall Electronics
PO Box 2027, Culver City, CA 90231
Tel: (800) 800-6608; Fax: (310) 391-8926
http://www.mars-cam.com/cable.html

A10•8 Analog Interface Cables
DC-DAXM Series DB25 to 8 male XLR’s
DC-DAXF Series DB25 to 8 female XLR’s
DC-DAS Series DB25 to 8 1/4” TRS connectors
Standard lengths: 3, 5, 10, 15, 20, 25 feet

D10•8 TDIF Interface Cables
DCD-88D Series DB25 to DB25.
Standard lengths: 1, 3, 6, 12, 15, 20, 25, 33 feet.

P10•8 AES/EBU Interface Cables
DC-SYX Series DB25 to 4 male, 4 female XLR’s
DC-DUB Series DB25 to DB25
Standard lengths: 3, 5, 10, 15, 20, 25 feet

Pro Co Sound, Inc.
135 E. Kalamazoo Ave., Kalamazoo, MI 49007
Tel: (800) 253-7360; Fax: (616) 388-9681
http://www.procosound.com

A10•8 Analog Interface Cables
DA-88 XM Series DB25 to 8 male XLR’s
DA-88 XF Series DB25 to 8 female XLR’s
DA-88 BQ Series DB25 to 8 1/4” TRS connectors
Standard lengths: 5, 10, 15, 20 feet

Other Cables
In addition to the companies listed above, the following companies supply individual 110Ω AES/EBU and/or 75Ω word clock and video cables:

Apogee Electronics Corporation
3145 Donald Douglas Loop South
Santa Monica, CA 90405-3210
Tel: (310) 915-1000; Fax: (310) 391-6262
http://www.apogeedigital.com

Canare
531 5th Street, Unit A, San Fernando, CA 91340
Tel: (818) 365-2446; Fax: (818) 365-0479
http://www.canare.com

Whirlwind
99 Ling Rd., Rochester, NY 14612
Tel: (888) 733-4396; Fax: (716) 865-8930
http://www.whirlwindusa.com
Troubleshooting and service

Although you probably won’t need them, troubleshooting tips can be found in the Reference Manual. Technical support is available by contacting your Mackie dealer, calling Mackie Designs at (800) 258-6883 (8:00 AM to 5:00 PM Pacific Time), or visiting Mackie’s website at www.mackie.com.

Please read the included warranty information, then complete and return the included Warranty Registration card, or it’s straight to bed for you with no dinner.

Colophon

Quick Start Guide text composed by Dana Bourke, based on a ballet by Jeff Gilbert. It was made possible by the teachings and donations of the HDR24/96 Design Team, most notably Brian McCully and Bob Tudor. Graphics and layout were performed by Tony “Waldog” Baird with technical support from Steve Eborall and Frank “Weasel Boy” Heller. Cover art courtesy of Bryan Tiller. Long-winded explanations, editing, and last minute updates from Mike Rivers, with proofreading and final blessing by Jeff Gilbert. Proofreading and additional editing by Linn Compton. Scott Garside was a pain the whole time.

Demo Music Credits

Ode to Masters

Written by: Jay Roberts and Rick Reid
Published By: Nigel Nose Music
Electric Guitar: Jay Roberts
Classical Guitar: Rick Reid
Bass: Dan Dean
Drums: Brendan Scanlan
Hammond B3: Joey DeFrancesco
Trumpet: Joey DeFrancesco

Little Bit of Love

Written by: Claude Gaudette & Alan Roy Scott BMI #877477
Published by: KYUSHU BOY MUSIC BMI #231306319
Artist: Shirley Meyers
Produced by: Keith Olsen
Arranged by: Claude Gaudette and Keith Olsen
Keyboards: Claude Gaudette, Richard Baker
Guitars: Tim Pierce
Engineered by: Keith Olsen and Peter Love
Recorded and Programmed at Goodnight LA Studios, Los Angeles

“Mackie,” the “Running Man” figure, “HDR24/96,” and “Digital 8•Bus” are trademarks or registered trademarks of Mackie Designs Inc. All other brand names mentioned are trademarks or registered trademarks of their respective holders, and are hereby acknowledged.